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1. Introduction

The SSC Tool is provided by ETG (EtherCAT Technology Group) and used for generate EtherCAT SSC
(SubDevice Stack Code). Any legal ETG members can use this tool to generate several workable SSC
sample codes that provide by BECKHOFF or other companies, or they also can specify their application
through the tool. This guide will describe how to import the configuration file of particular application and
generate related source files.

Note1: ASIX configuration file is based on SSC Tool v5.13
Note2: Please make sure your system has Microsoft EXCEL 2013 or later before using SSC Tool
Note3: This article will use “Ax58101_GpioAio” project as an example.

if you'll use other reference design project, please adjust the path as below of project, configuration and Excel
file by yourself.

® AX58101(2)_BSP

B Ax58101_GpioAio
BSP_ROOT\SampleCode\Ax58101_GpioAio\For_SSC_Tool\AX58101_GPIO_8Bit_AIO_16Bit.esp
BSP_ROOT\SampleCode\Ax58101_GpioAio\For_SSC_Tool\import\Configuration\AsixAx58101GpioAioConfigurations.xm
I

BSP_ROOT\SampleCode\Ax58101_GpioAio\For_SSC_Tool\import\Configuration\files\AX58101_GPIO_8Bit_AIO_6Bit.xls
X

B Ax58101_MotorControl
BSP_ROOT\SampleCode\Ax58101_MotorControl\For_SSC_Tool\AX58101_MotorControl.esp
BSP_ROOT\SampleCode\Ax58101_MotorControl\For_SSC_Tool\lmport\Configuration\AX58101_MotorControlConfigurati
ons.xml
BSP_ROOT\SampleCode\Ax58101_MotorControl\For_SSC_Tool\Import\Configuration\files\AX58101_MotorControl.xlsx
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2. Download The SSC Tool

You can download the SSC Tool through below hyperlink:
ETG SSC Tool Download

Click the link (red square) of below screen.

EtherCAT Technology Group || X +

&« > C & https://www.ethercat.org/en/downloads/downloads_0

EtherCAT.
erTechnolo;y Group injl> o]

MEMBER AREA
Search i d
EtherCAT Slave Stack Code (SSC) incl. OD-Tool Back T
EtherCAT The EtherCAT Slave Stack Code (S8C) from Beckhoff Automation is an example source code in ANSI C supperting both the pC and the SPI
o t interface. The code serves as 3 development base for implementation of EtherCAT in devices with own processor. The “Object Dictionary
EBEINSCON Toal” (OD-Tool) has been integrated into the SSC OD configuration tooling, supporting a consistent definition of offline and online object
FAQs dictionary.

Detailed product info can be found within the official EiherCAT Pro

Membership

Vendor ID The Slave Stack Code can be requested for free via the link below.
Product Guide Prerequistes for SSC download.

— ETG Membership
oW D — Valid EtherCAT Vendor 1D

Conformance

0d ZIP

Dec 01, 2017 5.12 Release

[ | EtherCAT Slave Stac!

Safety

TSN
Developers Forum

Knowledge Base

Figure 2-1

You must be an ETG member for download any contents from ETG website.
Please type your “User name”, “Password” and click “Login” for download.

p EtherCAT Technology Group | | X +

& https://www.ethercat.org/login

EtherCAT. ™

Technology Group

Search =
Member Area | Login
BT User name:
Organisation Passward:
FAQs

K I d in:
Membership £ep me foggeain

Vendor 1D
Login
Product Guide

Downloads
All content within the member area is intended for internal use of ETG members only. You may not

Conformance copy, distribute or "mirror” these files or printed version of the documents, or any part of it, for any
other purpose without permission in writing from the ETG (EtherCAT Technelegy Group).
EtherCAT P e .
Forget your password? Please send an email o inf
safety nams

t.org with your company and user

Developers Forum

Knowledge Base

Figure 2-2
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Type the EtherCAT Vendor ID of your company and click “Submit Registration *”.

EtherCAT Technology Group | X _ +

& ethercat.org

e—r
EtherCAT.

Technology Group ﬂﬂ E
MEMBER AREA
Search =
EtherCAT

Organisation

FAQs
Membership
g = Related Content
NeHEAD ET9300 EtherCAT Slave Stack Code | Registration
Product Guide Please check your company details and insert your EtherCAT Vendeor ID to register for
downloading the EtherCAT Slave Stack Code (SSC) from Beckhoff Automation GmbH & Co. KG for
Downloads free.

Conformance Registration

EtherCAT P (=) required field
Safety
Company: XXXXXX Company
Developers Forum
EtherCAT Vendor ID:  — Ox (4 Byte Hex-Code)
Knowledge Base
Logout Submit Registration*

*You will be redirected to a Beckhoff download page

Figure 2-3

Type “First Name”, “Last Name”, “Company”, “Email”, check “Data Privacy” and click “Submit’”.
BECKHOFF & Becknoff Waridwide my Bkt

= Company Products  Industries  Support

{t > Support » ET9300 EtherCAT Slave Stack Code | Download Request Product news (L] Product finder [3) Beckhoff Information System <> Download finder

Add your personal details to request the Slave Stack Code download link provided by email afterwards.

(] required fields

Personal information

Salutation B

First name *

Last name *

Company *

E-mail *

Download

Version *
S5CV5.13 (Tool 15.3) [~ ]

Data privacy *
T accept the Data privacy policy of Beckhoff Automation

1 agree that Beckhoff Automation may use my personal data to send me the slave stack code download link and related update information by e-mail

T accept the EtherCAT Slave Stack Code License (PDF)

Figure 2-4
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You will see below screen and receive the email later.

BEGKH"FF @ Beckhoff Worldwide @ ml!si‘egzl‘('hnff
y

= Company Products Industries  Support

(A Support > ET9300 EtherCAT Slave Stack Code | Download Request Productnews [[] Product finder [i] Beckhoff Information System <> Download finder

ET9300 EtherCAT Slave Stack Code | Download Request Y

Thank you for your interest in the EtherCAT Slave Stack Code.

Shortly you will receive an email with the download link for the EtherCAT Slave Stack Code.
Figure 2-5

You should click the download link in the received email and you will see below screen for download page.

BECKH“FF @ Beckhoff Worldwide @ myB'Slegzll(rhnff m

= Company Products Industries  Support

(A Support » ET3300 EtherCAT Slave Stack Code | Download Request > Download Productnews [ Product finder [i] Beckhoff Information System <> Download finder

Download ke

Thank you for your interest in the "EtherCAT Slave Stack Code". The download starts automatically.
If the process doesn't start, please click the download button.

Figure 2-6
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3. SSC Tool Installation

Below is an example how to install SSC Tool. Execute “EtherCAT SubDevice Stack Code Tool.exe”.

Name Date modified Type

€ EtherCAT Slave Design Quick Guide_V1i2 10/27/2017 5:32 AM  Chrome HTML Document
B EtherCAT Slave Stack Code Tool 2/6/2018 2:27 PM Application

€ EtherCAT SSC License V1.1 1/27/20159:06 AM  Chrome HTML Document
€ ReleaseNotes 11/27/2017 4:27 AM  Chrome HTML Document
1, SlaveFiles 2/6/2018 11:10 AM  Compressed (zipped) Folder
Figure 3-1
Select the language and click “OK”.
EtherCAT Slave Stack Code Tool - InstallShield Wizard ==

Select the language for the installation from the choices below.

| English (United States)

~)

| ok || canel

]

Figure 3-2
Click “Next >”.
15 EtherCAT Slave Stack Code Tool - InstallShield Wizard (=3
Welcome to the InstallShield Wizard for
44 EtherCAT Slave Stack Code Tool
The InstallShield(R) Wizard will install EtherCAT Slave Stack
Code Tool on your computer. To continue, dick Next.
WARNING: This program is protected by copyright law and
international treaties.
< Back [ MNext = ] [ Cancel
Figure 3-3
L=
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Check “l accept ...” and click “Next >”
ﬂ EtherCAT Slave Stack Code Tool - InstallShield Wizard

License Agreement

Please read the following license agreement carefully.

EtherCAT Slave Stack Code Tool -

This configuration tool faciltates working with the Beckhoff ET3300 EtherCAT Slave Stack
Code (35C).

t allows reducing the size of the S5C by removing unused code parts depending on the
desired configuration. This leads to better understanding and readability of the code.

Usage Hints:

- It is highly recommended to use only unmodified source code, as delivered with the tool AR

@ I accept the terms in the license agreement:

(7)1 do not accept the terms in the license agreement

InstallShield

[ < Back ][ Mext = ] [ Cancel

Figure 3-4

Type the “Organization”, “Vendor ID” and click “Next >”.
ﬁ! EtherCAT Slave Stack Code Tool - InstallShield Wizard

Customer Information

Flease enter your information.

User Name:

|'|.'I.|'indows

Organization:

WendorID:

InstallShield

[ < Back ][ Mext = ] [ Cancel

Figure 3-5
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Click “Install”.

13! EtherCAT Slave Stack Code Tool - InstallShield Wizard (3]

Ready to Install the Program _‘
The wizard is ready to begin installation. u

Click Install to begin the installation.

If you want to review or change any of your installation settings, didk Back. Click Cancel to
exit the wizard.

Instalishield
[ < Back ][ Install ] [ Cancel
Figure 3-6
Wait a while for installation.
3] EtherCAT Slave Stack Code Tool - InstallShield Wizard o] B |3
Installing EtherCAT Slave Stack Code Tool <h ‘4
The program features you selected are being installed. u

Please wait while the InstallShield Wizard installs EtherCAT Slave Stack Code
Tool. This may take several minutes.

Status:

InztallShield

< BackK ENT =

Figure 3-7
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Click “Finish”.

15! EtherCAT Slave Stack Code Tool - InstallShield Wizard

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed EtherCAT
Slave Stack Code Tool. Click Finish to exit the wizard.

[7] Launch EtherCAT Slave Stack Code Tool

[T] show the Windows Installer log

< Back Finish Cancel

Figure 3-8

The SSC Tool shortcut already exists in your start menu.

,;’jjj Paint

|I_:ir Getting Started 3

! Connect to a Projector

:| Calculator

Documents

Pictures

Sticky Motes

% Snipping Tool

3 S5¢ Tool

1‘ KPS Viewer

@’J Windows Fax and Scan

Music

Cormnputer

Control Panel

Devices and Printers
Default Programs

m EEPROM Programmer Help and Support

»

All Programs

|Seam" programs and files m

e | Lo €
Figure 3-9
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4. Import Configuration File

If the old configuration already be imported in SSC Tool of your environment, please do below 2 steps for
remove it. If your SSC Tool is first time to execute, please see next page.

Step 1: Click “Tool -> Options”
BER AX58101_GPIO_8Bit_AIQ_1EBit - Slave Stack Code Tool

File  Project Help
Show Conflict Window lave Settings
=- AE58101_GGFI - 2 .
----SlaveIn.fu:urrr| Options B ?ers.mn .
gzrnim EEPROM Programmer ol e Vo
- EtherCAT 3 Application *
. Smehroni s apeapple
- Application
i ProcessData aoeappl.h
Ma-‘lh':_'x appllnterface h
- Compiler
hootmode &
Figure 4-1
Step 2: Select the configuration item, click “-” icon and “OK”.
Slave Stack Code Tool | Options n
Generic  Editor  Create Files Configurations
=
(ARSI S (I SIN WA (W [Vendor: RASIX Electronics Corporation (0xE0Q000BSS) . -~

Versiom: 1.0.0.0

NOTE: This configuration is not provided by Beckhoff
Butomation and files or £file fragments may be added which
are MNOT covered by the license from Beckhoff Zutomation
GmbH .

Shall be set if the Slave code executes with an AX52101
device. The application should run with an AXS52101
evaluation board from BRSIX Electronics and STM32F303
NUCLEC-€4 board from STMicroelectronic and regquires the SDE
for building the project. This file is included in the RSTX
A¥58101 SDE (http://WWW.asix.com.tw/). Please contact ASTX
Electronics Corporation for any further information.

< > W

0k | [ Camal |

Figure 4-2
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If your SSC Tool is first time to execute and you will see below screen. If you removed old configuration as
above-mentioned, just click “File -> New”, you will also see below screen.
Please select “Custom” field and click “Import”.

Slave Stack Code Tool
File Project Tool Help
Slave Project Navigation Slave Settings

Slave Stack Code Tool | New Project

Default

© Custom |EL9800 | 2Axis GA402 Sample

This configuration provides a CiA402 sample application for the new EL3800 EtherCAT
Evaluation Kit.

The comesponding device description is located in file "..\esi\Slave StackCode xml" (device:
EL9800_CiA402) or will be created with this tool.

Figure 4-3

Select the configuration file in the path below and click “Open”.

“BSP_ROOT\SampleCode\Ax58101_GpioAio\For_SSC_Tool\import\Configuration\AsixAx58101GpioAi
oConfigurations.xml”

B Import Configuration file(s) X
“ v <« |mport » Configuration » v | O Search Configuration »
Organize v New folder ==~ [ o
s
L Mame Date modified Type
# Quick access
0 Deskiop files File folder
6 AsixAx58101GpioAicConfigurations XML File
‘ Downleads
|| Documents
| Pictures
v £ >
File name: | AsixAx58101GpioAioConfigurations V‘ S5C Tool configuration file ~
Figure 4-4

Copyright (C) 2025 Reserved by ASIX Electronics Corporation



- AX58x01(2)
VASTX SSC Tool Configuration Import User Guide

You will see below screen. The “ASIX AX58101 | 8BIT GPIO, 16BIT AlO <ASIX Electronic Corporation>"
appears in the Custom filed. Please click “OK”.

Slave Stack Code Tool | Mew Project n
() Default

(®) Custorn | ASTX AXS8101 |8BIT GPID, 16EIT AIO <ASTX Electronics Corporstions ~
Vendor: 431X Electronics Corporation (xEQ000BE25). "~
Version: 1.0.0.0

NOTE: Thiz configuration iz not provided by Beckhoff Automation and files or file

fragments may be added which ave NOT covered by the license from Beckhoff Automation
GmbH.

Shall be set if the Slave code executes with an AX58101 device. The application should ron
weith an A3 58101 evaluation board from ASTE Electrondcs and STM32E203 NUCLED-64
board from & TMicroelectronic and reguires the SDE for buildine the proect. This file iz o

Import (0]:4

Figure 4-5
Click “Yes”.

Slave Stack Code Tool 3

External files need to be added to activate the configuration.
' Do you want to proceed?

NOTE:

These files are not covered by the license from Beckhoff Automation
GmbH & Co. KG.

Figure 4-6

It will back to main screen of SSC Tool. Please click “Tool -> Application -> Import”.

EtherCAT Slave* - Slave Stack Code Tool = o]
File Project | Tool | Help
Slave Project Navigq ii Show Conflict Window

-} EtherCAT Slave Options

12

Slavelnform

Generic EEPROM Programmer 400

;T,:‘é;: cl ~ Application | Create new Version 4

BhaCAT 511

Synchronisation Import ‘ g

(- Application aoeapplh i 511
ProcessData applinterface h EcatAppl EtherCAT application 512
M,allb,mf bootmode ¢ ESM EtherCAT State Machine 512
Figure 4-7

Select the excel file in the path below and click “Open”.

“‘“BSP_ROOT\SampleCode\AX58101_GpioAio\For_SSC_Tool\Import\Configuration\files\AX58101_GPIO
_8Bit_AIO_16Bit.xIsx”

Then press “OK” to close excel file parsing logger dialog.

15
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Save this SSC project by click “File -> Save As”.
EtherCAT Slave” - Slave Stack Code Tool

File | Project Tool Help
J ] New Ctri+N Slave Settings
= Open Ctrl+O SSC Version 512
@l Save  Ctrl+S Config File Version 1.4.0.0
Save As ] File name Description
Bt aoeappl.c AoE ADS over EtherCAT
T RppICEtoT aoeapplh
ProcessData applinterface h EcatAppl EtherCAT application
Ma:bof bootmode.c ESM EtherCAT State Machine
e bootmode h
bootloaderappl.c Bootloader Bootloader Sample
bootloaderappl h
Figure 4-8

You can overwrite the file in
“BSP_ROOT\SampleC

ode\AX58101_GpioAio\For_SSC_Tool\AX58101_GPIO_8Bit

]
X

=@

Version
511 =‘
511 3
512
512
5.11
512
512

P

AIO_16Bit.esp’.

B8 Save Slave Proje e s
« v <« Ax58101_GpioAio » For_55C_Tool v O Search For_55C_Tool 2
Organize ~ New folder F= - o
[ This PC Name Date modified Type Sii
) 3D Objects Import 2 File folder
[ Desktop Src 2 File folder
) Documents Bt AX58101_GPIO_3Bit_AIO_16Bit 2 ESP File
* Downloads
J‘ Music Confirm Save As
&= Pictures AX58101_GPIO_8Rit_AIQ_16Bit.esp already exists.
m Videos Do you want to replace it?
i Local Disk (C:)
— Local Disk (D) Yes
[_ﬂ' MNetwark |
v £ »
ZIELELEMAXS5E101_GPIO_8Bit AIO_16Bit] V‘
Save as type: | Slave Tool Project ~
|~ Hide Folders Save Cancel
i .
Figure 4-9
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It will come back to main screen. Click “Project -> Create new Slave Files”.

EtherCAT Slave - Slave Stack Code Tool — [m| X
Slave Settings
SRC Version
Config File Version

File name

~

- EtherCAT $tate Machine
Symchronistion
& ﬁpplljfna:fs]:Dm apeapplh ERS1

- Madlhox appllnterdace h Ecathppl EtherCAT application 513

- Compiler
bootmode.; ESM EtherCAT Btate Machine 512
bootmade. b 511
hootloaderappl & Booflnader Booflnader Sample 512
bootloaderspplh 512
ciad(02apple Cih402appl CiA402 Sample Lpplication 513
ciad2applh 513
raeannl o TaF AN Annliratinn Profils aver Fthed " AT 513 4

444 File(s)
Conflicts

9 Info & Warning @Error

Figure 4-10

Then here will start to generate SSC source code, before press the “Start” button, please check the file paths
are correct.
If the code generation is successfully as the figure below, click “OK” and “Close” to finish the procedure.

Project File |v100_20250604\Samp13(30de\&x581 01_Gpiokic'For_S8C_ToolX58101_GPIO_SEit AIO_16Bitesp
Source Folder | X58101(2)_BSP_v100_20250604'SampleCodetd»58101_Gpindin'For_S8C_Tool¥re!

ESI File WampleCod et x58101_Gpinkic\For_S3C_ToolAX 58101 _GPIO_SBit AIO_16Bitxml
DA 58101 (21 DevelopmentESFAE 58101 (2)_ESF_100_20250604'3ampleCod bl i

Progress
{ "ecatslv_h"™ : new file written ~
: "esc.h"™ : new file written
1 "foeappl.c™ : new file written
1 "foeappl -h™ : new file writ|

"mailbox.c™ : new file writ| Lreate Files Finished — — O x

"mailbox.h"™ : new file writ

"objdef.c" : new file writt]

"objdef . h" : new file writt Wew files created successtully .

"sdoserv.c™ : new file writ
"sdoserv.h"™ : new file writ
"AX58101 Hw.c™ : new file W Open Folder
"A¥S8101 Hw.h" : new file w
"RES8101_GPIC 8Bit AIC 1€Bif T - new I1le WIltten
"AXS28101_GPIC SBit AIC l€éBit.h" : new file written

"R¥X58101_ Foelppl.c" : new file written

"R¥58101_ Foelppl.h" : new file written 1
"R¥X58101_ GPIC 5Bit AIO 1éBitlbjects.h"™ : new file written

Generate files finished

Create device description finished "D:\AX58101 (2)‘\Development\BSPYWAXS58101(2)_BSP_wl0O0_

20250604 \SampleCode\Ax58101 Gpiokio\For_ SSC Tool\AXS5S8101 GPIO 3Bit ATO 1&€Bit.xml"™

Create Slawve files finished

Close

Figure 4-11
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Then the generated source code can be found as below.

e

Name Date modified Type Size

[ applinterface H File 12 KB
[ AX58101_FoeAppl CFile 12 KB
[& Ax58101_FoeAppl H File 4KE
[ AX58101_GPIO_8Bit_AIO_16Bit C File 16 KB
[ AX58101_GPIO_8Bit_AIO_16Bit H File 3KE
[ AX58101_GPIO_BBit_AIO_16BitObjects H File 18 KB
[ AX58101_Hw CFile 45KB
[ AX58101_Hw H File 16 KB
[2f bootmode C File 12 KB
[2f bootmade H File 3KB
[2f coeappl C File 36 KB
[ coeappl H File 4KB
[l ecat_def H File 24 KB
[ ecatappl C File 44 KB
[ ecatappl H File TKB
IQ{’ ecatcoe C File 7TKE
IQ{ ecatcoe H File 5KB
Gl ecatfoe C File 17KB
[cif ecatfoe H File 8KB
[ ecatslv C File 103 KB
[ ecatslv H File 30 KB
[ esc H File 14KB
[ foeappl C File 11KB
& foeappl H File 5KB
[ mailbox C File 39 KB
[ mailbox H File 9 KB
[ objdef C File 78 KB
[2f objdef H File 15KB
[Zf sdoserv C File 52 KB
[ sdoserv H File KB

Figure 4-12
e
18
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Evaluation Board License Agreement

By using this evaluation board or kit (together with all associated software, hardware and documentation
provided by ASIX, collectively, the "Evaluation Board"), you ("You") agree to be bound by the terms and
conditions of this Evaluation Board License Agreement ("Agreement "). Do not use the evaluation board until
you have read and agreed to this agreement. Your use of the Evaluation Board constitutes your acceptance
of this Agreement.

License:

ASIX Electronics (“ASIX”) grants you the right to use the accompanying evaluation board, which provides
limited functionality, for the sole purpose of evaluating and testing ASIX products for your evaluation and
testing purposes in a research and development environment. Under no circumstances should the evaluation
board be assembled, directly or indirectly, as part of any of your products, as it has been developed for
evaluation purposes only and has no direct functionality and is not a finished product.

Notice:

(1) The description of hardware circuit, software tools and other related information in this document are only
used to illustrate the operation of application examples for ASIX Electronic products. You are solely
responsible for the use of such circuits, software and information in the design of your equipment. ASIX
Electronics is not responsible for any losses arising out of the use of the circuit, software or information by
you or a third party.

(2) ASIX Electronics has taken reasonable care in describing the information in this document, but ASIX
Electronics does not warrant that such information is error-free. ASIX Electronics disclaims all liability for
any damages you may suffer as a result of errors or omissions in the information contained herein.

(3) ASIX Electronics shall not be liable for infringement of patents, copyrights or other intellectual property
rights of third parties due to the use of ASIX Electronics products or the technical information described in
this document. No license, express or implied, or otherwise, is granted under any patent, copyright or
other intellectual property rights of ASIX Electronics or others.

(4) You may not alter, modify, copy or otherwise misappropriate any ASIX electronic product, whether in
whole or in part. ASIX Electronics shall not be liable for any loss incurred by you or a third party as a
result of altering, modifying, copying or otherwise misappropriating ASIX Electronics products.

(5) You should use the ASIX Electronic products described in this document within the range specified by
ASIX Electronic, especially the maximum rating, operating power supply voltage range, mobile power
supply voltage range, heat radiation characteristics, installation and other product characteristics. ASIX
Electronics accepts no liability for malfunctions or damages resulting from use of ASIX Electronics
products outside of such designations.

(6) When using ASIX electronic products, please comply with all applicable laws and regulations that regulate
the inclusion or use of controlled substances, including but not limited to the EU RoHS Directive. ASIX
Electronics disclaims all liability for damage or loss resulting from your failure to comply with applicable
laws and regulations.

(7) The buyer or distributor of ASIX electronic products is responsible for distributing, disposing of or
otherwise placing the product to a third party, and notifying the third party of the contents and conditions
specified in this document in advance, ASIX Electronics shall not be liable for any loss suffered as a result
of authorized use of ASIX Electronics products.

(8) This document may not be reproduced or reproduced in any form, in whole or in part, without the prior
written consent of ASIX Electronics.

19
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Copyright © 2025 ASIX Electronics Corporation. All rights reserved.
DISCLAIMER

No part of this document may be reproduced or transmitted in any form or by any means, electronic or
mechanical, including photocopying and recording, for any purpose, without the express written permission of
ASIX. ASIX may make changes to the product specifications and descriptions in this document at any time,
without notice.

ASIX provides this document “as is” without warranty of any kind, either expressed or implied, including
without limitation warranties of merchantability, fitness for a particular purpose, and non-infringement.

Designers must not rely on the absence or characteristics of any features or registers marked “reserved”,
“undefined” or “NC”. ASIX reserves these for future definition and shall have no responsibility whatsoever for
conflicts or incompatibilities arising from future changes to them. Always contact ASIX to get the latest
document before starting a design of ASIX products.

TRADEMARKS

ASIX, the ASIX logo are registered trademarks of ASIX Electronics Corporation. All other trademarks are the
property of their respective owners.

EtherCAT® is a registered trademark and patented technology, licensed by Beckhoff Automation GmbH,
Germany.
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